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Revision History 

1/24/17 

 Original draft created. 

2/1/17 

 Updates to Encrypted SecureMail Functionality. 

2/8/17 

 Added Digital Imaging update for new VaTech HD sensor. 

2/28/17 

 Updates to Merging Patient Records regarding the selection of target and duplicate patients. 

 Updates to Practice Config, Updates to Diagnosis Coding Configuration regarding the additional option 
of contacting Greenway Support to synchronize all fee schedules to the diagnosis prompt. 

3/10/17 

 Added Practice Config, New Launch Screen Option item in System Administration. 

 Draft status removed. 
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Overview 

The following summary highlights some of the new features, enhancements, and changes contained in 
MediaDent version 11.20: 

 Chart Email Attachments – Users may now insert progress notes, macros, and images into outgoing 
emails as attachments. 

 Secure Email – All emails sent through MediaDent will now be encrypted by default. Enhancements 
include procedures for creating user MediaDent SecureMail accounts. 

 Chart Imaging – The Export Images, Print Images, and Image Selection windows have been reorganized 
for more clarity. 

 Moving Chart Images – Images in Chart may be moved from one patient’s record to another. 

 System Administration Practice Configuration – A Practice Config section has been added to the 
System Administration module in the MediaDent Console. All configuration options previously located 
in System Files  Practice Control Info  Practice Info have been migrated to this screen; the Practice 
Information screen has been removed from System Files. 

 Utilities – A new Utilities module has been added that enables users to merge duplicate patient records 
into a single record. 
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 New Features/Enhancements 

Appointment Center 

Changes to No-Show/Broken Appointments 
Project #B-49736, B-54489 

 

The following changes have been made to no-show/broken appointments on the Appointment Book. 

 Appointments whose status has been changed to No Show will now remain on the Appointment Book 
and display the No Show color in the appointment slot. No-show appointments will no longer be 
removed from the Appointment Book. 

 If a user selects to use a previously scheduled No Show appointment when scheduling a future 
appointment, a copy of the original No Show appointment will remain on the appointment book for 
future reference.  

Chart 

Chart Optimization 
Project #B-49679 

Enhancements have been made to the Chart module to improve efficiency and performance. 

Email Enhancements 
Project #B-50469, B-49701, B-49769, B-51236, B-51249 

 

An Email icon has been added to the main navigation bar in the Chart module that enables users to create and 
send emails from anywhere in the MediaDent Console. The Email icon is enabled as long as a patient is in 
context on screen.  
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1. Click the icon to display the Compose Email Message window. 

 

2. To send an email, enter the email address or addresses in the appropriate fields (To, Cc…, and Bcc…).  

3. Enter a Subject and enter the appropriate content in the body of the email. 

4. To attach a progress note to an email: 

 Select the Reporting tab. 

 Select the date/time of the appropriate progress note, click Generate Report, and click Attach to Email 
to add the progress report to the outgoing message. 

 
5. To insert a macro or image into an email: 

 

 Select the Insert tab. 
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 To insert a macro, select the appropriate macro(s) from the Macros drop-down list to insert it into the 
body of the email at the cursor point. 

 

 To insert an image, select the Images icon to launch the Image Selection window and select the 
appropriate image(s) to attach to the outgoing message. 

 
6. All attachments may be viewed in the Attachments field on the Compose Email Message window. Users 

may delete any attachment by clicking the delete link (X) for the appropriate attachment. 

 

7. To edit the email, select the Edit tab and make the appropriate edits. 
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To change the view for the email, select the View tab and adjust the view as needed. 

 

8. Click Send Message to send the email. 

Note - If a user switches to a different patient before sending an email, a Warning message displays indicating 
that an unsent email exists. 

 
Users may click Send Email to send the message, Discard Email to delete the message, or Cancel to cancel and 
return to the original patient. 

Encrypted SecureMail Functionality 
Project #B-50474, B-50425, B-51246 

All emails sent through MediaDent will now be encrypted by default. Users will need to create a MediaDent 
SecureMail account to read all MediaDent-generated emails. 

Configuring Email Accounts 

A new Email Configuration option on the Misc tab in System Administration enables clients to configure their 
system to use MediaDent SecureMail. 

 

The MediaDent SecureMail option is selected by default. Users may select the Default Email Client option if 
their in-house email system encrypts emails in compliance with HIPAA regulations. 

Caution -  MediaDent SecureMail is HIPAA compliant and secure for sending patient data in accordance with 
all relevant regulations. Selecting the Default Email Client option displays a warning message regarding the 
status of external email servers: 
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Hosted clients should use MediaDent SecureMail for all outbound messages. Do not select the Default Email 
Client option if your server is not HIPAA compliant and not secure for sending patient data. 

Creating a MediaDent SecureMail Account 

First-time SecureMail recipients will need to create a MediaDent SecureMail account. 

1. When you receive an email indicating a SecureMail message is waiting for you, click the link in the body of 
the email message to navigate to the MediaDent SecureMail webpage. 

 

 

2. Enter your First Name, Last Name, a Password for your email account, and Re-enter Password. 

3. Click Create Account. A screen displaying all secure emails displays. 
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4. Select the appropriate email message in the left-hand column to read it. The message will display in the 
right-hand column. 

 

5. Click Download PDF to download the message in PDF format, or Print to print a copy of the message. 

Note - Emails will automatically be deleted after 90 days from the date of receipt. 

6. Once your SecureMail account has been created, links to all future emails will navigate you to the main 
SecureMail login page. 

 

To access secure emails, enter your Email and Password and click Login. 

Note - With the introduction of encrypted email for all MediaDent messages, users will no longer receive the 
Encryption Password prompt when encrypting an email through the MediaDent application. 
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Imaging Tab, Changes to Export Images Window 
Project #B-49700 

 

The layout of the Export Images window has been modified as follows: 

 Export Settings – A new Export Settings section has been added that houses the Export Format, File 
Name, and Output Folder fields. 

 

 Image Selection – A new Image Selection field houses the Image Library, View (formerly Filter), 
Available Images, and Selected Images fields. 

 

 Drag-and-Drop – Users may select an image for export by clicking the appropriate image in the 
Available Images field and dragging it to the Selected Images field, and vice versa. (Users may also use 
the arrows to move images back and forth between the fields.) 
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Imaging Tab, Changes to Print Images Window 
Project #B-53441 

 

The layout of the Print Images window has been modified as follows: 

 Image Selection – A new Image Selection field houses the Image Library and View (formerly Filter) 
fields. 

 

 Image Information – The Image Name, Date Taken, Taken By, and Contains Teeth fields have been 
moved to an information bar below the Available Images and Selected Images fields. Information is 
displayed by single-clicking the appropriate image. 

 Drag-and-Drop – Users may select an image for export by clicking the appropriate image in the 
Available Images field and dragging it to the Selected Images field, and vice versa. (Users may also use 
the arrows to move images back and forth between the fields.) 
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Imaging Tab, Images Movable Between Patients 
Project #B-53438 

 

Users may move images from one patient to another via the Move Images option on the Imaging tab. 

When the user clicks Move Images on the Imaging toolbar, the Image Selection window displays with (new) 
Move Settings. Users may select the appropriate Target Patient and Target Library and move the appropriate 
image(s) per the normal method. 

Users may add another folder in the Target Library by clicking the + icon and creating the appropriate folder via 
the Add Library dialog box. 

 

Meds Icon Selection Launches Medications Within Chart (SuccessEHS 
Integrated) 
Project #B-49705 

For SuccessEHS Integrated users, clicking the Medications icon on the main Chart navigation ribbon will now 
launch the Medications tab within the SuccessEHS Chart module (as opposed to a standalone Medications 
screen). 

Odontogram, New Filter for Graphical Analysis 
Project #B-49687 

 

A Tooth Filters Apply To option has been added to the Tooth Info grid in the Odontogram that enables users to 
maintain the current view when other filters (Completed, Existing, Planned, Today’s Work Only) are enabled. 
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You may select the appropriate scenario for which the Tooth Info filters operate: 

 Both (default) – Tooth Info filters apply to both the Odontogram and the Tooth Info grid 

 Tooth Info Grid Only – Tooth Info filters apply only to the Tooth Info grid; the Odontogram view will not 
change 

 Odontogram Only – Tooth Info filters apply only to the Odontogram; the Tooth Info grid view will not 
change 

These preferences are also in effect for Blank Charts. 

Patient Search Modifications 
Project #B-49731 

The rules for patient searches have been modified as follows: 

Patient Name Search 

 Patient searches by name will be performed as a “begins with” search for both the first name and last 
name. 

Example: if you enter Thomas in a search field, the system will search for all first and last names 
beginning with Thomas and display those results. 

Patient ID Search 

 Patient searches by ID number will be performed as follows: 

 If an ID number is entered that is an exact match, only the patient that matches the ID number 
entered will display as the search result. 

 If an ID number is entered that is not an exact match, the system will search for the number in all 
available numerical fields and display those results. 

Example: If you enter 1234 in a search field and that ID number is not matched to a patient, the 
system will search for all number strings with 1234 (ID, SSN, phone number, etc.) and display those 
results. 
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Walkout, New Image Selection Menu for NEA Attachments 
Project #B-53439 

 

A new Image Selection window has been added to the NEA Attachment Requirements window that replaces 
the NEA Image Export window.  

 

 Selected Image Parameters – This section houses the Image Code and Image Orientation controls. 

 Image Selection – This section houses the Image Library, View (formerly Filter), Available Images, and 
Selected Images fields. 

 Drag-and-Drop – Users may select an image for export by clicking the appropriate image in the 
Available Images field and dragging it to the Selected Images field, and vice versa. (Users may also use 
the arrows to move images back and forth between the fields.) 

Digital Imaging 

Support for VaTech HD Sensor 
Project #B-50744 

Digital Imaging has been updated to support the new VaTech HD sensor. 
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System Administration 

Practice Configuration Migrated to System Administration in MD 
Console  
Project #B-49768, B-54406 

 

A Practice Config section has been added to the System Administration module in the MediaDent Console.  

All configuration options previously located in System Files  Practice Control Info  Practice Info have been 
migrated to this screen; the Practice Information screen has been removed from System Files. 

 The System Admin section/tab has been renamed Security. 

 The Misc tab will display by default when users access the Practice Config section. 

Practice Config, Updates to Diagnosis Coding Configuration  
Project #B-51657 

 

The Enable Diagnosis Coding option under Meaningful Use Configuration on the Misc tab on the Practice 
Configuration window in System Administration has been updated to prompt  users in Chart ONLY if certain 
diagnosis codes are configured “prompt for Dx” Fee Schedules.  
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 Enabling (checking) this option directs the system to view each diagnosis code in Chart to see if it has 
been configured in Fee Schedules to display a prompt. If the code is set to prompt and is marked 
Completed, the prompt will display. 

 Disabling (unchecking) this option will not direct the system to search diagnosis codes for the prompt 
setting. 

 Users may set diagnosis codes to display a prompt in Chart by selecting (checking) the (new) Prompt for 
Dx checkbox on the Fee List window in Fee Schedules for the appropriate codes. Codes that are 
configured in this manner will enable the prompt in Chart. 

 
If the practice does not want a warning in Chart when an item is marked completed, do not configure 
the fee schedule as such. 

 Users may, after selecting the Prompt for Dx option, contact Greenway Support to have all of their 
fee schedules synchronized to the diagnosis prompting. 

Note - This setting still applies to the Walkout screen; if users need warnings in Walkout, this setting should 
remain checked. 

Practice Config, New Chart Tab 
Project #B-54403, B-54407 

 

A Chart tab has been added to the Practice Config screen in System Administration.  

The following configuration settings are available on the tab: 
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Chart 

 Automatically lock existing work in chart after ___ day(s) – Enables users to set a time limit after which 
any Existing work on a patient’s chart is frozen and cannot be edited. 

 Automatically lock perio data after ___ day(s) – Enables users to set a time limit after which any perio 
data on a patient’s chart is frozen and cannot be edited. 

Progress Notes 

 Autosave interval – Enables users to set a timeframe for auto-saving progress notes.  

 Spell Check Dictionary – Enables users to select whether the spell check dictionary is in effect Per User 
or Per Database. 

 Automatically lock progress note after ___ Days/Hours – Enables users to set a time limit after which 
progress notes are frozen and cannot be edited. 

Lab Work 

 Automatically Create Patient Task for Overdue Lab Work – Enables users to establish a date in the 
Overdue as of field after which all overdue lab work will automatically generate a task on the Patient 
Tasks section of the Patient Communication screen. 

 
Note - Only one task will be created per overdue lab item. 

If the lab work is marked as Received, the task will be automatically deleted. 
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Practice Config, New Launch Screen Option 
Project #B-49768 

 

A MediaDent Launch Screen section has been added to the Misc tab on the Practice Config screen in System 
Administration that enables users to select which screen displays upon initial login to MediaDent. 

  

Clients may select the Appointments or Open Tasks/Heritage screen to display when they first log in to 
MediaDent. 

Practice Config, New Default Mail Client Option (Premise Clients Only) 
Project #B-51252 
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Note - This feature is for Premise clients only. 

A Default Email Client section has been added to the Misc tab on the Practice Config screen in System 
Administration for transmitting secure emails. 

 

Clients may select the MediaDent SecureMail (default) or their Default Mail Client as the system by which 
emails will be transmitted/received.  

 Selecting the Default Email Client option will change the Email icon to a Copy Email icon. Clicking the 
Copy Email icon will copy the subject, recipient, body, and any attachments of the email to the client’s 
default email screen (as if the email was sent directly from the client’s email). 

Note - The Default Email Client selection is only enabled if an external mail client has been configured in 
System Files. 
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Utilities (new) 

A Utilities module has been added to the MediaDent Console that enables users to perform several tasks 
related to patient records. 

 

Merge Utility  
The new Merge Utility enables users to merge duplicate patient records into a single record. 

Configuring Security Access 

 

Access to the Merge Utility may be configured at the role level or the user level in Security. 

A Patient Merge access feature option has been added to the Role Level Configuration and User Level 
Configuration screens. Users may move the Patient Merge option from the Denied column to the Allowed 
column to enable the utility at the role or user level. 
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Accessing the Merge Utility Window 

To access the Merge Utility window, click Merge Utility on the Utilities window. 

 

Merging Patient Records 

To merge duplicate patient records into a single record: 

1. Search for the appropriate patient on the Individual Merge tab. 

 

 Enter the appropriate search criteria in the Patient Search Criteria field. You may search by last name, 
first name, birth date, SSN, sex, or a combination of these. 

Note - At least one search criteria must be entered to perform the search. 

 Click the Search button. (To clear the search field, click Clear.) A list of all patient records matching the 
search criteria displays on the Found Duplicate Patients grid. 
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2. Select (check) the appropriate checkbox(es) in the Dup column to indicate all potential patient records to be 
merged. 

 

3. Select the target patient (i.e., the patient record that you want to keep) by clicking in the * column to 
designate the appropriate record as the target patient. An asterisk (*) will display in the column. 

 

Note - All merged information will be placed in the target patient record. All duplicate patient records will be 
deleted once the merge is complete. 

Caution -  Please ensure that you have selected the correct target record. The target record with the asterisk 
designation will be the main record into which all duplicate records will be merged. All information in the 
target record takes precedence and will override any duplicate information from the other records.  
 
If necessary, you may review any patient record in full by right-clicking on the record and clicking the Patient 
Properties button to open the Patient Properties window in Practice Navigator. 

 
 

 

4. Click the Merge button to merge the selected patient records. A confirmation dialog box with the patient 
numbers that were merged displays the status of patient merges. 
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Successful Merge              Failed Merge 

Click OK to close the dialog box. 

Understanding Merged Data 

The following table outlines the behavior of merged data between duplicate and target. 

Information/Location After the merge… 

Practice Navigator 

Patient Properties window – 
Patient tab 

Demographic information for the target patient will be the default 
information after a merge. 

 Special Indicators fields – Since patients may have up to four 
special indicator codes, any codes from the duplicate patient will 
populate in the Special Indicators fields on the Patient tab if the 
same codes are not already present on the target patient. 

Patient Properties window – 
Insurance tab 

All information in the Patient Information, Primary Plan Information, 
and/or Secondary Plan Information sections on the Insurance tab will 
default to the target patient.  

Patient and Account Notes 
window – Patient Notes tab 

All information from both the duplicate and target patients will be kept 
on the target patient’s record.  

Patient Documents window 

Account Ledger window 

Payment Assignments 
window 

Treatment Plan Properties 
window 

Scheduling 

Patient Appointments 
window 

Appointment information from both the duplicate and target patients 
will be kept on the target patient’s record. This includes both past and 
future appointment information.   
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Medical Alerts window 

 If duplicate alerts exist between the duplicate and target 
patients, the merge will default to the target patient’s alerts. 

 If different alerts exist between the duplicate and target 
patients, both sets of alerts will be kept on the target patient’s 
record. 

Chart module 

Charting tab 

Charting information for the target patient will be the default 
information after a merge. 

 Odontogram – If the duplicate patient includes pathology 
findings that are not on the target patient’s odontogram, the 
duplicate patient’s findings will be included on the target 
patient’s record.  

Perio tab 

Perio information for the target patient will be the default information 
after a merge. 

 If the duplicate and target patients have different information 
recorded, both sets of perio data will populate on the target 
patient’s record. 

Progress Notes tab 

All information from both the duplicate and target patients will be kept 
on the target patient’s record.  

Imaging tab 

Lab Work 

Medications  
Medications from both the duplicate and target patients will be kept on 
the target patient’s record.  

Financial  

Patient Merge with Same Guarantor 

Patient merges that have the same guarantor will move all information from the duplicate patient to the 
target patient’s record. 

Patient Merge with Different Guarantors 

Unapplied Balances 
The user should manually apply as much of the unapplied balance as 
possible before performing the merge. 

Payments/Credits 
All payments and credits will remain with the duplicate patient’s record. 
No payments/credits will be moved to the target patient. 

Outstanding Balances 
 A debit will be created on the target patient’s record for each 

provider that has an outstanding balance from a duplicate 
patient. 
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 A credit will be created on the duplicate patient’s record for 
record for each provider that has an outstanding balance from a 
duplicate patient. 

Note - Users must manually apply the credits on the duplicate 
patient account(s) to the appropriate line items via the Account 
Ledger. 

Viewing Merged Patient History 

The Merge History tab enables users to view a history of all patient merges. 

 

To view merge history: 

1. Enter the appropriate search criteria in the Patient Search Criteria field. You may search by date range 
(patient merges before/after a certain date), merge user, last name, first name, birth date, SSN, sex, patient 
ID, or a combination of these. 

Note - At least one search criteria must be entered to perform the search. 

2. Click the Search button. (To clear the search field, click Clear.) A list of all patient records matching the 
search criteria displays on the Merged Patients grid. 

 

The following information is available for viewing: 

 New Patient # 

 Old Patient # 

 New External ID 

 Old External ID 

 Last Name 

 First Name 

 Middle 

 Sex 

 Birthdate 

 SSN 
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 Merge Date 

 Merge User 

Merged Failed Notification Receipt (Intergy integrated clients only) 

When users perform a patient merge in Intergy, MediaDent is notified alerting them of the merge and then 
Mediadent tries to merge the patients automatically. If the merge fails, an email alert may be sent indicating a 
failed merge. Users can then manually merge the patients using the merge utility.  

Intergy-integrated users may be configured to receive email notifications about failed merges by selecting the 
appropriate user in the Merge Failed Notification Recipient drop-down list on the Notifications tab under 
Practice Configuration in the System Administration module. 

 

Note - Only one user may receive failed notification requests. 
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